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A. Background 
 
As described in the Scope of Work, this BIOFOR task order facilitated the creation of two 
products. One is a geographic information system (GIS) to assist staff working on USAID/G-
CAP’s Regional Environmental Program for Central America (PROARCA). The other product is 
a geo-referenced management information system (MIS) to assist the System for Central 
American Integration’s (SICA) Central American Commission for Environment and 
Development (CCAD) in coordinating and facilitating environmental and natural resource 
activities throughout the region. 
 
The purpose of this document, the Final Report, is to: 
 

• Summarize our methodology used to complete this task order 
• Discuss the utility of products prepared through this task order 
• Provide recommendations for PROARCA’s next steps in the use of GIS technology 
• Provide recommendations on how the MIS could be enhanced to provide greater value 

for CCAD 
 

B. Project Methodology 
 
Chemonics directed and oversaw CATIE’s hands-on development of the GIS, MIS, and training. 
Chemonics’ technical advisors, Mike Paquette and Mohamed Khatouri, worked closely with 
CATIE to establish design specifications and product standards for task order deliverables. As 
the project progressed, the Chemonics’ technical advisors tested the GIS and MIS tools and 
explored additional methods for organizing and analyzing data specific to PROARCA and 
CCAD’s distinct missions.  Claudio Saito and Amy Bodmann facilitated communication 
between the task order team and local stakeholders. This helped ensure that team members 
understood the needs of these stakeholders, and that these needs were addressed appropriately 
during development. 
 
This task order started up in Central America on the week of April 15. The Chemonics team of 
Mike Paquette, Mohamed Khatouri, Claudio Saito, and Amy Bodmann, together with Jeff Jones 
of CATIE, met with USAID and PROARCA personnel in Guatemala and with CCAD staff in El 
Salvador, and finished the week with a two-day work planning session in Costa Rica. The goal of 
these meetings was to gain a more detailed understanding of the user requirements and 
expectations for each of the task order products. Another important goal was the identification of 
individuals from PROARCA and CCAD who would participate during the development process 
by responding to information requests, critiquing development artifacts, and providing feedback 
on interim products.  
 
An important step in the execution of this task order was production of the Inception Report 
which made our development effort more transparent and participatory. Produced in early May, 
this document: 
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• Presented our proposed methodology for completing the task order 
• Provided a description of the two primary products based on the requirements gathered 

by that time 
• Described the training to be provided and its role in the overall success of the project 
• Presented the schedule of key events and milestones 

 
In the second week of June, Chemonics and CATIE conducted meetings with CCAD to explore 
and uncover user requirements of the geo-referenced MIS. As a result of this dialog, the team 
obtained a fairly significant understanding of CCAD’s broader project management information 
needs. The key to success in this portion of the task order was determining what part of their 
broader information management requirements would benefit from visualization and analysis 
using GIS technology. 
 
Throughout the entire project, Chemonics worked closely with CATIE on the design, 
development, and review of PROARCA’s geographic databases. Chemonics personnel worked, 
at times, side-by-side with CATIE’s analysts to evaluate production problems and remedy data 
layer specific issues. 
 
At project mid-term, the Chemonics team met with the task order reference groups and others to 
discuss progress to date. In addition, issues that were unforeseen at the onset of the project were 
presented and explored further by those in attendance. The Chemonics team met with USAID 
and PROARCA personnel in Guatemala and with CCAD staff in El Salvador. These meetings 
contributed in a substantial way to the success of the project by keeping reference groups 
engaged and involved in task order decisions. 
 
The final phase of the project focused on training PROARCA and CCAD staff in the use of GIS 
technology to support their specific missions. Our goal was to equip individuals with a good 
foundation in GIS principals and provide a significant hands-on experience using the PROARCA 
GIS or the CCAD MIS product. The trainees received instruction on the basic operation of 
ArcView, methods of investigating data, procedures for integrating data, and communication 
techniques using map products. 
  

C. Utility of Task Order Products 
 
C1. PROARCA GIS 
 
The PROARCA GIS is a project administration tool for use by USAID and PROARCA 
personnel in planning the location of field activities, and as a coordination and communication 
tool. The system allows users to visually analyze pertinent data and produce communication 
outputs such as maps and tabular reports. This GIS facilitates the planning of project activities in 
relation to other relevant projects, natural terrain features (river network, land cover, elevation, 
etc.), environmental characteristics (ecosystems, protected areas), physical infrastructure 
(transportation network), and administrative boundaries. The system enables USAID and 
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PROARCA staff to integrate and analyze multiple factors while coordinating current and future 
field activities. 
 
The PROARCA GIS consists of a custom ArcView project file; one file for each of the four 
PROARCA focus areas (Gulf of Honduras Watershed, Moskitia Coastal Zone Watershed, Gulf 
of Fonseca Watershed, and Gandoca Bocas del Toro Watershed). Within each project file, a 
primary ArcView View contains each of the system’s data layers. Each layer is appropriately 
symbolized using point markers, line styles, or fill patterns as required. 
 
The full suite of data editing, spatial analysis, and map development functions are available 
through ArcView’s standard user interface. The USAID and PROARCA staffs, however, are 
expected to rely primarily on visual analysis to accomplish their mission, which requires use of 
the more fundamental functions (such as pan, zoom, turn off/on select data layers). The 
PROARCA staff also needs to use data editing functions to maintain spatial data layers that 
represent their field activities. ArcView’s standard user interface includes those functions that 
allow representing field activities using points, lines, or more complex polygon symbology.  
 
The PROARCA GIS include the data layers shown in the following table. 
 
Item Data Layer Description 
1 Country, department, and municipality boundaries 
2 Principal cities or towns 
3 Road network (primary, secondary, tertiary) 
4 Unclassified LANDSAT Imagery 
5 River network 
6 Watershed boundaries 
7 Elevation contours 
8 Land use 
9 Ecosystems 
10 Protected area locations 
11 Rainfall 
12 Length of dry season 
 
Each of the GIS data products consists of four separate pieces. Each piece covers the geographic 
extent of one of the four PROARCA focus areas (Gulf of Honduras Watershed, Moskitia Coastal 
Zone Watershed, Gulf of Fonseca Watershed, and Gandoca Bocas del Toro Watershed). 
 
C2. CCAD MIS 
 
The CCAD MIS is an executive information system for use by SICA’s General Directorate for 
the Environment and associated staff. It is expected that users would spend no more than 10 
minutes at one sitting to assess the status of environmental activities throughout Central 
America. This MIS tool requires minimal training. It can answer questions such as, “How many 
ongoing activities in Central America will contribute to improved biodiversity and forests? 
Where specifically are these activities occurring? What is the current funding level for these 
activities? What partners are funding these activities?”   
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CCAD can use the MIS to communicate environment and natural resource management activity 
levels. The tool will produce maps and related text products depicting the entire region or 
portions thereof. 
 
The CCAD MIS consists of a highly customized ESRI ArcView application. The user interface 
contains a limited number of menu and tool bar items to facilitate panning, zooming, and the 
display of data layers. In addition to visual analysis, the interface contains a query tool to allow 
selection and identification of environmental activities using a number project attributes (such as 
project strategic focus, value, period of performance, and financing source) Furthermore, menu 
items generate standard map and report products. 
 
The MIS contains three types of data. First, it contains base geography layers (e.g., 
administrative boundaries, principal cities and towns, and road network) to provide a relative 
geographic framework for locating environmental activities. Second, it contains select 
environmental layers (ecosystem boundaries and protected areas) with broad natural resource 
management utility. Third, it contains the CCAD Project layer. The CCAD Project layer is a 
dynamic data layer that represents CCAD’s current project portfolio. 
  
Data fields within the CCAD Project layer include: 
 

 Identification Number 
 Title 
 Project Type 
 Start Date 
 End Date 
 Status 
 Objective 
 CCAD Strategic Area (permits up to 4 entries)  
 Environmental Classification Theme (permits up to 3 entries) 
 CCAD Coordinator 
 Financing Source (permits up to 3 entries) 
 Financing Source Contact (permits up to 3 entries) 
 Funding Total 
 Implementing Organization (permits up to 3 entries) 
 Implementing Organization Contact (permits up to 3 entries) 
 Countries Benefited 
 Geographic Zones Benefited 
 Results 
 Event Total 
 Attendance Women 
 Attendance Men 

 
The CCAD MIS product is a functioning pilot application. With its current capabilities, the MIS 
is beneficial to CCAD’s General Directorate for managing some of its project data. However, the 
Chemonics team determined at the onset of this effort that CCAD’s project information 
management requirements go well beyond the scope of this task order. In addition to the 
previously stated utility of the MIS, use of the system should contribute to CCAD’s effort in 
uncovering the broader information management requirements for its oversight mission. 
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D. Recommendations 
 
D1. PROARCA GIS 
 
As a result of this task order, PROARCA personnel have a readily accessible base set of 
geographic data useful for planning and coordination of field activities. To make broader use of 
this data product investment, the following steps should be taken: 
 

• Provide training opportunities, similar to that supplied under this task order, for other key 
PROARCA personnel. This will enable more staff to make use of GIS technology for 
planning, coordination, and other tasks that involve basic analysis or presentation of 
spatially related data. 

• Procure additional ArcView licenses and low volume color printers (paper sizes up to 
13”x19”) as needed for technical staff. 

• Perform a GIS needs assessment to determine: 
o Which PROARCA processes would benefit significantly from the application of 

advanced spatial analysis, environmental modeling, and/or information management 
techniques 

o What supplemental data products would be needed to undertake these advanced GIS 
applications 

o What additional training would be needed for staff to employ advanced techniques 
 
Examples of such applications include protected area management, watershed erosion 
control, watershed pollution control, water resources management, land use evaluation, and 
coastal resources management. 

 
D2. CCAD MIS 
 
During the first phase of this task order, it became evident that CCAD needed a substantial 
Project Information Management System to house the various pieces of data tracked for its 
projects. Working within the limits of this task order, the Chemonics team established an 
information system that manages a select set of these project attributes. The following steps need 
to be taken to effectively manage the entire set of project attributes: 
 

• Perform a formal information system requirements analysis to establish CCAD’s static 
and temporal project information needs 

• Design and develop a Project Information Management System that facilitates local and 
remote data entry, querying, and reporting of CCAD’s environmental and natural 
resource projects 

• Design and develop a GIS interface to the Project Information Management System that 
facilitates local and remote spatial queries and creation of map and tabular outputs. The 
design should be based on the staff’s hands-on experience gained while using the MIS 
developed under this task order 
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Using ArcView 3.2 

1. Introduction to Arcview 3.2 

ArcView is a tool to make analysis and to display geographical information. It allows the 
user to combine different geographical themes and it prints satisfactory results without a 
lot of effort. In this exercise we will use ArcView to make some geographical analyses. 
At the same time we will be able to appreciate the capacity of analysis of geographical 
systems of information (SIG). See the support documentation ArcView (Help) for further 
details on the terminology of ArcView. 

The process to display of geographical information 

The process to display geographical information in ArcView is quite simple. One only 
has to take into account the most important steps: 

To create a view (view) 
To add themes (themes [layers, coverages, etc.]) to the view. 

Each step has its details that help to manage and to make the display of geographical 
information more efficient. For example, after creating a view it is convenient to give it a 
unique name, with its respective description, and to specify the information on the 
reference system in use. In a similar way when adding a theme in the view, one should 
give it a unique name, classify it and to improve its colors. Finally, the design is the 
cartographic touch that is applied, to print a good map. With all this the process is as 
follows: 

To create a view: 
Give a name to the view. 
Provide descriptive information of the view. 
Specify the units of the reference system. 

To add themes: 
Give a name to the theme. 
Classify the theme. 
Improve the colors. 
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Understanding Arcview View 

Control 
Window 

Menu of 
views 

Menu of 
tables 

Menu of 
layouts 

Theme 

Definitions of Arcview 

View : Window where themes are inserted. 
Theme : Class or geographical object (layers, coverage, etc.) 
Design : Cartographic leaf to print views (layout). 
Table : Electronic leaf that has information on themes. 
Project : Group of views, themes, tables, and designs, of a session ArcView. 
Coverage : Class or native geographical object of Arcinfo. 
Shape : Class or native geographical object of ArcView. 
Attributes : Information in table form on each geographical object. 
Relationship : Connection between the table of attributes of a theme and other tables 
of data. 

Introduction to ArcView 3.2 -2- 
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Working with ArcView 
I 

, 

In the following practice you will display information of the Cuenca river, Lempa in 
ArcView. You will create a view, to add themes and to classify them, and to print the 
results. Execute the following instructions step for step. Don't forget to read the Notes. 

I 

To create a view and to add a theme 

1. Begin ArcView / * START 11 PROGRAMS 11 ESRl 11 ARCVIEW GIs 11 ARCVIEW 
GIs 

2. Click on the option with a new View, and click OK. (a view will be created) 

3. Click Yes when asked to add a theme to the view. (A theme will be inserted.) 
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4. Specify the unit of disks in Drives. I * to see image below 
5. Double-click the portfolio where its themes are. 
6. Double-click the theme municipalities. 
7. Click the square that precedes the name municipalities in the legend. 

Names of the 
themes to 

insert in the 
view 

Theme files 

Disk drive 
source for the 
access of 
data 

Activated -b 
theme 

Theme 
inserted in 
the view 

Note: to insert subsequent themes in the view, you only have to click in the menu View 
11 Add Theme and to specify (click) the name of the new theme. 

The specified theme should be displayed on the screen, inserted in the view that you 
created. The color of the theme is assigned automatically. Later on, it will be necessary 
to classify it and to improve its colors. Up until now we have executed 2 of the 3 

--  - 
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necessary steps to display themes: we have created a view and inserted a theme. Now 
all we have to do is print. 

Giving names to the views 

I The views should have specific names to be differentiated. A project can have many 
views, each containing different themes or groups of themes. This process is relatively 
simple to very easy. 

, 
1. Select the 'control window' of ArcView. Click on the Views icon, click on the name 

of the view (in general 'Viewl I), and finally click on Open. The view with its 
respective themes will be activated. 

The 'View' in 
the window 
of control 

2. Go to the menu and click on View 11 Properties. 

The first 
name that 
ArcView will 
assign to the 
view (Viewl) 
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3. In the section Name write the new name of the view. See example. 
4. In the section Creator write your name. 
5. Specify the units of the reference system in meters in the Map Units and the 

Distance units in kilometers. 
6. And in the section of Comments write a more complete description of this view. 
7. Finally click OK. 

Name of the 
view I, 

Name of the 
author I, 

The system 
of units for -+ 
reference and 
measuring 

Description 
the view Of+ 

Note : you will see the new name in  the upper part of the window of the view. One 
can alter the name and other details of the view in its properties at any time by 
clicking on View 11 Properties. Always have in mind that the name of the view 
tries to explain its content in a brief form; this is very useful when one has 
several views that represent several themes in a single project of ArcView. The 
units of the reference system should be specified to be able to display the 
corresponding scale in the design. In the section of Comments there is more 
space to rewrite the view and its content. 

New name of 
the window 
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Giving names to themes 
To give names to each theme that we insert in a view is very important. When a theme 
is inserted it takes the name of the coverage or file shape in which it has been kept; in 
general, these names are not so explanatory, since they obey the restrictions imposed 
by the operating system of the computer. It is a good habit to give a more explanatory 
name to each theme that we insert; the convenient thing is to change the name when 
you insert the theme to avoid confusions in the future: each theme that is inserted 
should have a different name. Further on you will see that when you open the database 
of a theme, the table takes the name of the theme automatically; if the theme does not 
have a clear name, the table will also reflect that problem. 

1. Make sure that the view is active. Click on the theme Legend to activate it. 

The legend of 
the theme 

2. Click Theme 1 1  Properties. (The window of Theme Properties will be activated) 
3. Click on the Definition icon and on the section of Theme Name write the new 

name of the theme (it is brief). In Comments you write a description of the theme. 
4. Click OK 

Note: The legend of the theme in the view will reflect the new name. Click in File 11 
Set Working Directory to specify the work portfolio. Write c:\proarca if their 
portfolio is in 'C:  ' and is called 'proarca .' 
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Review 

Until this moment you have learnt the following things: 

To create a view: 
To create a view and add a theme. 
To provide descriptive information of the view. 
To specify the units of the reference system. 

To add themes: 
To give names to a theme. 

Classifying themes 
In this part of the exercise we will assign better colors to the theme that we have in the 
view. ArcView has assigned a uniform color to the whole theme. In our case, the theme 
that we have reflects the municipalities of the 3 countries, El Salvador, Guatemala, and 
Honduras. We will classify the municipalities by country to be able to determine where 
each country belongs. 

I. Make sure that the theme is active. Click Theme 11 Edit Legend. (The window of 
Legend Editor will be activated.) 

2. The Legend Type should be Unique Value (nominal classification.) 
3. The Value Field should be Country. 
4. Click Apply and close the window of Legend Editor. 

The type of 
legend 

Classification 
fields 
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Note: The theme displays the municipalities classified for each country. The 
classification type to use is important and goes according to the values of the 
classification field. In our case, the classification field is 'Country ' and its values 
are El SALVIDOR, GUATEMALA, HONDURAS; therefore, the ideal thing is to 
make a nominal classification (Unique Valued). When the field to use is numeric 
and each value represents a hierarchical scale, then the ideal thing is to make 
an ordinal classification (Graduated Colors); an example would be population, 
data or levels of agricultural and industrial production, elevation, types of slopes, 
etc. Classifications of the use of the earth and coverage of the floor are in 
general, nominal classifications, although a number is assigned to represent 
each class or use. 

Changing the colors of the classification 
In general the colors generated automatically by ArcView are not the best. It is for that 
reason that we should change them or alter them to our pleasure and obey conventions 
that are already established (hydrological objects are assigned blue colors and greens 
for forest). 

1. Activate the window Legend Editor of the theme. (Double-click the legend of the 
theme in the view, or go to the Theme 11 Legend Editor.) 

2. In the Legend Editor window, double-click in the first legend symbol. (The 
window Color Palette will be activated.) 
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Step 2 

n j Honduras I Hondurat 

I' 

Step 3 

3. Click the brush of the Color Palette. 
4. Click the color that you wish to assign to the legend. 
5. Repeat step 2 and 4 for the other legends. 
6. Click Apply when finished. Close the Legend Editor and Color Palette. 

Note: you can alter the colors as many times as you want, by repeating the 
process. Remember that when printed the clear colors are dark and the dark 
colors are too dark. There is a great difference between the colors shown on the 
screen and the colors actually on the printer. 

Review 

Until this moment you have learnt the following things: 

To create a view: 
To give a view a visible name. 
To provide descriptive information of the view. 
To specify the units of the reference system. 

To add themes: 
To give a name to the theme. 
To classify the theme. 
To improve their colors. 
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Zooming In & Out and Panning 

1. Click the button of Zoom In. 

Zoom In Zoom Out Pan Full Extent 

2. Move the cursor to the center of the map 
3. Press the left button of the mouse and pull the mouse down, then, pull the mouse 

toward the right, and finally release the button. (You will see a 'zoom ' of the 
delineated area.) 

4. To execute Pan, single click the corresponding button. Press the left button of the 
mouse, and pull the mouse to the side while continuing to press the mouse button. 
Release the button to stop Panning. 

5. To execute Zoom Out, press the corresponding button and click in the map. 
6.  To return to the original map press the button Full Extent. 

Note: Practice 'Zoom' and 'Pan ' for about 2 or 3 minutes. 

Obtaining information on geographical objects 
The theme of the view on the screen contains information or attributes on the 
geographical geometric objects (vector) that it represents. The table of attributes is 
essential for each theme or geographical class. Each geographical geometric class 
(vector layers) has a table of attributes. One can add fields to these tables of attributes 
to record vital information on each geographical object; however, one should only add 
the relationship fields to these tables of attributes, additional information should be 
recorded in other tables of data. 

Geographical geometric class (Vector) Table of attributes for the vector 
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1. Make a 'zoom in  ' on an area of El Salvador. 
2. Click the ldentify button, to obtain information. 

3. Click inside any municipality. The window ldentify Results will appear in the 
screen displaying information on the geographical object. 

Note: Obtaining information for other municipalities of El Salvador. Make sure of 
using Pan and Zoom to move from an area to another. Repeat the step 3 for 
Guatemala and Honduras. Every time that you click, ArcView opens the table of 
attributes of the vector and show its contents in the window of ldentify Results. 
Close the sale ldentify Results when finished. 

Saving an Arcview project 

Keeping the project for the first time. . 

1. Click File 11 Save Project. 
2. Double-click on the portfolio where you record your data. 
3. Click and write the name of the project in File Name. You can use the name 

ejerciciol .apr 
4. Click OK. 

Note: The name ejerciciol.apr is  the name of the project. The view and the theme 
have been kept in this project. All the projects ArcView takes the extension ' .apr 
' at the end of the name, which means ' ArcView Project'. 

Keeping the project for second time and other times. . . 

1. Click the Save button of the list of icons of ArcView. 

Note: This time saving the project was easier. The project can be saved many times 
as one wants. One can create views and insert more themes, but the project will 
be the same one. When the project is saved, ArcView keeps the position of all 
the windows within the project until to the moment of saving. When one opens 
the project again, ArcView displays the most recent state in which the project 
was saved. 
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Leaving ArcView 
We have to leave ArcView to learn how to open projects that we have created 
previously. The process is very simple. 

1. Click File 11 Exit. 

Note: ArcView will sometimes ask him if you if you want to keep the project 
before closing. ArcView detects any changes made in the project from the last 
save. 
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l!. Legends: Types of Legends, Creation and Editing 

1. Start ArcView (a portfolio exists called ESRI in the menu of programs). 
Indicate to the program that you want 

2. Open the called project c:\proarca\ejer2-av\editor-Ieyendas.apr. The view 
called Central America shows the theme of the same name and it represents 
the political division of the area at the municipality level (equivalent to canton 
in Costa Rica). 

Color and types of legends 
3. Open the Legend Editor making a double click on the theme Central 

America in the table of contents. 

Change the legend type to Unique Value. Select the Value Field like admin.- 
I1 which is the name of the field in the table that contains the names of all the 
countries. Click in Apply. The program chooses an outline of colors (color 
schemes) called Bountiful Harvest, but you try with other outline colors. 

1 

4. Click on Apply and close the Legend Editor. The map of Central America 
spreads in function of the field that contains the name of the country to which 
each municipality belongs on the map and therefore each country has a 
different color. 
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Classification methods 
5. Again, go to the Legend Editor and change the legend type to Graduated 

Color and the Classification Field z1990 (Population of each municipality at 
1990). Select a different Color Ramp-Cyan Monochromatic and click on 
Apply. 
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6. Again enter to the Editor window of the Legend and normalize the 
classification choosing Normalized by Area. Click On OK. 

Legends 
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What difference do you find among the classification of step 17 and the 
normal ired classification? Why? 

To change the classification method, the number of classes and labels 
7. Again go to the Editor window of the Legend and make on the button 

Classify ... Change the type to Quantile. Select 3 as the number of classes 
and click on OK. 
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What difference do you find among the classification of the step 17, 18 and the 
classification for cuantiles? (Do you remember what is a cuantil) 

8. Still in the Legend Editor, in the Label column, click on the first value and 
write the word Bajo and press Enter. On the second value write Medio and 
press Enter and then on the last value write Alto and then press Enter. Now 
press Apply. 
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9. Close the view called Central America 

Point density maps 

Suppose now that as part of a program of environmental education, you want to 
examine the pattern of distribution of the number of students in that educational 
level at a level of hidrografica basin. A way to present this information is to use a 
map of density points to show the concentration of an attribute. 

10. Open the view called GUATEMALA. In it, you will find two themes: one 
corresponding to the populated places of the Republic of Guatemala with 
more than 10000 inhabitants and the other corresponding to the division of 
the country in their respective main hidrograficas basins. Activate the theme 
Cuencas Hidrograficas. 
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11. Open the Legend Editor and choose Dot from the menu list of the legend 
type. In the menu list of the field of density (Density Field), select 
Sum-Primaria (see figure at the end of step 26). 

Notice that the field Dot Legend shows that 1 point is similar to 0.00000 students. 
To fix the number of students that each point represents, you can type in a value or 
click on the Calculate button. In the last case the program calculates the number 
of students that better represents a point in relation to the size of the window of the 
view. 

12. Click on Calculate. ArcView calculates the number of students that will 
represent each point in this case. (it depends on the resolution of the 
monitor). ArcView has determined that a point will represent 2000 students. 
Now the color of the background will be selected for the density map. 

13. Double click on the rectangle Background Symbol to display the Palette 
(Palette Fill). In the Palette change the pattern for omission from transparent 
to solid (the black rectangle). 

- 
el: 14. Click on the Color Palette zz button, and select the rose color r . Click on 

Apply. 
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15. One can observe that the biggest concentration of primary school students is 
in the central part of Guatemala and very few are in the north part (Peten). 

Classification with graphics 
Now the map of the population's distribution will be used for all the educational 
levels (pre-primary, primary, secondary and higher). A pie table will be used. 

16. In the menu of the Legend Type choose Table. The pie table is the graph for 
omission. In the list of fields to the left click on Sum-Preprima. Continue to 
press the Shift key and click in Sum-Primaria, Sum-media and 
Sum-upper. Click on the Add button. 
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Now the fields are shown to the right with a symbol for each. You may change these 
symbols with a double click on the color, but for now leave them as they are. 

17. Click Qn the Properties button to display the dialogue box of the properties of 
the pie table. 

18. In the list menu of Size Field, select Pob-tot. The values of this field will 
control the size of each piece of the pie table. 

19. In the list menu of Minum Size and Maximun Size, type 8 and 18, 
respectively. This fixes the radii (in points) for the smallest and the biggest 
graph. Click on OK in the dialogue box of the properties of the pie table and 
then Apply in the Legend Editor. 

ArcView displays the four fields using the pie table. The table seem a little big for 
that scale so we will use the zoom. 
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20. Click on the Zoom In tool and drag a box around the central basins. Now you 
will be able to see a pie table for each basin. 

Now we will be change the pie table to a bar table. 

21. In the Legend Editor, locates the icon for Legend Type (Table Type) b 
and click on the symbol Bar Table, then click on Apply. ArcView displays the 
same four fields using a bar table. As you will be able to observe, a great 
quantity of graphics present relatively same amounts of information when in 
fact the difference among students of primary and the other levels is 
significantly bigger. This is a difficulty that you have with the program to 
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represent values too dissimilar. Therefore we will proceed to normalize 
according to the population's total. 

22. Display the Legend Editor and in the menu of Normalized by, choose the 
field Pob-tot. 

23. Click on the Properties button to display the dialogue box of the properties of 
the bar tables. Choose 8 as the minimum height and 18 as the maximum 
height and then click OK. 

24. Click Apply on the Legend Editor. Now you will notice that the bars are more 
representative of the comparative value of each one of them. 
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Use of graduated symbols 

Now we will display the populated Places based on their total population. 

25. Using the Legend Editor fix the Legend Type of the theme Cuencas 
Hidrografica to Single Symbol and put a background color that contrasts with 
the color of the points that define the Populated Places. 

26. Make visible the theme of Populated Places 

27. Double click on the theme Populated Places to display the Legend Editor. 
In the Legend Editor, change the Legend Type to Graduated Symbol and 
fix the classification field to Pob-tot. Click on Apply. 
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Now one can observe five classes, each with a different symbol size. Now the 
symbol will be changed to one that is more distinctive. To make it, we will add 
municipal markers to the Marker Palette. 

28. Double click on the rectangle Symbol in the left lower part to open the Marker 
Palette. 

29. Click on the Font Palette in the upper part of the window of palettes. 

30. Widen the window to be able to see the complete name of each source. 
Locate the source ESRI Cartography and click to illuminate it. Click on the 
button Create Markers in the lower part of the window. This button converts 
the characters of the source selected in the symbols markers and adds them 
to the Palette's of Markers. 

1 ESRI Conservat~on 

~ ~ z e :  114 3 T I 
Style i ~ o r r n a l  / 

&a$ Markers ] 
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- 
31. Change to the Marker Palette 1s: after pressing Create Markers. The 

characters of the source ESRl Cartography is-added to the end of the palette. 

32. Move down the contents of the window until you see the symbol of the Greek 
temple in the upper part of the window. Click on the symbol 

33. Close the Marker Palette. 

34. Click in Apply in the Legend Editor. The map that shows the places 
populated with more than 10000 inhabitants, categorized according to size 
and represented by a Greek temple. 
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35. To observe the results more closely, zoom in onto an area. You will notice 
that when you makes an approach, the symbols don't become bigger. If you 
want the symbols to become bigger when making an approach, you will need 
to activate the scaling. 

36. First it is necessary to return to the window that displays the complete map. 

Click on the button of Zoom to Previous Extent 10 , to return to the 
previous scale, until you return to the complete view. 

37. In the final part of the Legend Editor, click on the Advanced button. In the 
dialogue box of the advanced options, click on the checkbox of Scale 
Symbols to activate the scaling. Click on OK, then click on Apply in the 
Legend Editor. 

38. Zoom again to an area of the map. Now you will see that the symbols appear 
bigger. 
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39. Close the project and don't save the changes made. 
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I!!. Managing databases: Creating and Editing Tables 

In this part of the exercise we will work with a table of earth data that is kept 
separately from the table of the theme. First the table will be added to the project, 
then we will make changes in its appearance, we will edit the values and add a new 
registration and a field. 

Adding tables in ArcView 

1. If it is necessary start ArcView (a portfolio called ESRl exists in the menu of 
programs). 

2. Open the project called c:\proarca\ejer3av\edicion-tablas.apr. When the 
view opens up you will have a view of the lots that correspond to the urban 
area of the City of Turrialba, Carthage, Costa Rica. Now you will add a table 
called Use from the Tierra.dbf to this project and then edit it. Close the View 
and click on the Project Window to make it activate. From the Project menu 
select Add Table. In the dialogue box that appears select dBase (" .dbf) from 
the list of file types. Navigate to the directory where the data are 
(c:\proarca\ejer3av). Click on Use of the Tierra.dbf to highlight it and then 
click on OK. 

What other file type can be loaded when you want to add a table (notice the list of 
file types) and what characteristics does each one of them have? 

3. The table that appears contains the area, perimeter, the parcel identification, 
the lot number, the neighborhood, the price / m2 of the earth, the use to 
which the lot is dedicated and the use code. Examine the table to familiarize 
with it. 
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Changing the display of the table 

When you edit the data of a table (for example: change the values of the fields, add or 
to erase registrations and fields) the data source of the table modifies. This means that 
if you add a table to another project the change will be reflected in it. When changes 
are made to the appearance of the table (to rename the table, to hide fields or to 
change the width of the field), the changes only apply inside the project where they 
were made. First we will change the appearance of the table. 

4. From the Table menu, select Properties to open the respective dialogue box. 

5. In the column called Visible, click the checkbox of the field Numlote to hide it 
in the display. 

6. Click on the Perimeter line of the Alias column and write Perimeter (to make 
a rename for the display). Make all the changes that are observed in the 
following figure. 
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I 
V~sible Fiald Alias 

7. Now we will make the fields wider so that you can write a title in each one of 
them. Position the cursor in the vertical line among the header of the field 
Parcel identification and the header of Neighborhood (Barrio). The cursor 
changes to an arrow with double head. Click and drag more or less a half 
inch toward the right. Repeat the same step with other fields where it is not 
possible to read the complete name. 

Adding values and adding a records 
8. Go to the first registration of the table. From the Table menu select Start 

Editing. The proprietor of the lot with Parcel identification No.11852, has 
communicated to the municipal registration of property that it built a house 
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and therefore it will be necessary to change the use of the ground to low 
medium class Residence and the use code 503. 

Now we will look for the registration that has changed. Select the header 
corresponding to the name of the field Parcel identification making a click in 
the name of the table, in such a way that it changes from a gray color to a 
dark gray and that it appears to be sunken. 

Then press the tool for ordering fields in descending sequence (there is also 
a tool for an upward sequence) and now look for the Parcel identification 

No. 11 852. 

Press the edit button (only when this button is pressed is it possible to 
write in the cells of the table). Click on the cell that corresponds to the field 
Uso de la tierra (Use of the Earth) and change it to low middle class 
residence. Make sure that the writing in this field is the same as the other 
fields that already existent (with uppercase, lowercase and symbols), 
because if you writes it differently, it affects the database, and would be 
recognized as a new Use of the Earth. Now change the value from the Code 
of Use to 503. 
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12. When making a visual inspection of the Barrio del Silencio, it was found that 
a registration doesn't exist for one of the lots for that neighborhood. We will 
add a registration (line) to the database. From the Edit menu selects Add 
Record, then go to the lowest part of the table. A new registration is added to 
the table. You have zeros in the numeric fields and there is white in the field 
of characters (string). 

13. Click on the Uso de la tierra field and on the area of the new registration and 
write 921.659, then press the Tab key. 

14. In the Perimeter field write 121.8722 and press the Tab key 

15. Continue this procedure until the cells are fill like as is shown in the previous 
figure. When finished typing the Code of Use press the Enter key. 

Add a field and calculate values 
Now the value each lot will be calculated for each one of the properties. To do this we 
will add a field and fill it making a mathematical operation in the fields. 

16. From the Edit menu choose Add Field to display the respective dialogue 
box. In the entrance box for the name write Val-lote. The type of data is a 
Number and the width is 20 characters. The number of decimals will be 2. 
Click on OK to add the new field to the table. The new field appears selected 
in the new table. 
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17. Click on the button Field Calculator. The calculator field appears. In the 
text box an expression will be built telling ArcView which values to put in the 
new field. 

18. In the Fields list locate the field Val-lote and double click on it. in the 
Requests list double click on the multiplication sign ("* "). Again, in the Fields 
list locate the field Precio-m2 (it values the earth for a square meter in 
Colons) and double click on it. The expression will appear this way: 

19. Click on OK. Each cell in the new field contains the value of the lot. 
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20. Add a new Field called "Tax" and fill it with values that signify 0.5% of the 
value of the property. Apply what was learnt previously. 

21. From the Table menu, select Stop Editing. Click on Yes to save the 
changes. 

22. Close the project. Click on No, we have already saved the changes on the 
table in the previous step. 
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Associating and linking tables 

23. Start ArcView (a portfolio called ESRl exists in the menu of programs). 
L 

I 24. Open the project called c:\proarca\ejer4av\asoc-tablas.apr. When the view 
opens up you will have a view with the lots of a part of downtown Turrialba. 

25. Click on the button Open Theme Table @ to display the respective table. 

26. Move to the right of the table and observe the fields, with which you should 
be familiar with. It was used in the previous exercise. 
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To add a table to the project 

27. Click on the window of the project to make it active. In the icons panel, click 
on the icon Tables. 

28. Notice that in addition to the Attributes of Lots table, the project already 
contains a table called Proprietors (you will open this table later). Click on 
the Add button. In the dialogue box Add Table, navigate to the directory 
c:\proarca\ejer4av. Double click in vulnerabilidad.dbf to add it to the 
project. This table contains the data of a survey that was carried out to 
determine the number of levels (floors) that the constructions have, the 
construction material and if they have some degree of vulnerability to 
landslides or floods. 

To associate tables in ArcView 

When you unite tables, ArcView temporarily annexes the fields of a table (the table 
source) to another table (the table destination). To associate two tables, the tables 
should share a common field of information (it is not necessarily to have the same 
name, but should mean the same thing within their content). ArcView uses the 
values of this field to pair the registrations in the two tables. It is important therefore 
that the relationship of the registrations between the destination tables and the 
source is from one to one or of many to one. 

29. Move the table vulnerabilidad.dbf to the left corner of the upper window of 
the application (you can maximize the screen to have more observation 
space). The table vulnerabilidad.dbf is the source table in the association 
operation. Their fields will be annexed to the table of the theme. 

30. In the table vulnerabilidad.dbf, click on the header of the field Parcelid to 
make it active. This will be the common field to be used in the association of 
the tables. 

31. Click on the table Attributes of Lots to make it activates. Move to the right of 
the table and click on the header of the field Parcelid to make it active. 
Attributes of Lots is the destination table. Notice that the destination table 
contains 454 registrations (one for each parcel), while the source contains 
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6595 registrations (one for each lot in the whole database). The relationship 
among the registrations is from one to one. 

32. Move the table Attributes of Lots to the lower right corner of the application 
window. Make sure that the table Attributes of Lots is active (The cintillo of 
the title appears in blue color) The destination table in an association is 
always the table that should be active. 
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33. Click on the Join button. The table vulnerabilidad.dbf closes and its fields 
are annexed to the table of the theme (Attibutes o f  Lots). 
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34. Move to the right of the table. The vulnerability fields at the end of the table 
have been annexed by the association operation. These fields now can be 
used for classification and analysis. 

Using an associated field to display the theme 

Now we are ready to classify and display the theme Lots based on the associate field 
Material. 

35. Click on the view to make it activate. Then double click on the legend to open 

the Legend Editor. 

36. Select Unique Value as the legend type. 

37. Select Material as the value for the classification field. Each class of 
construction material is assigned a color, according to the color outline for 
omission. We will change this outline. 

38. In the lowest part of Legend Editor, click on the button Random Colors. 

Make successive clicks until you obtain a color outline that you like. 
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39. Click on the Apply button to make the color outline visible, then close the 
Legend Editor. 

It is noticed that the descriptions don't fit in the view of the legend. There are 
some ways to remedy this situation. You can enlarge the width of the view of 
the legend, but to the cost of making the display of the map smaller. A better 
solution is to edit the labels in the Legend Editor. In this case, however, it 
will simply hide the legend, since it is too long and too wide. 

40. From the Theme menu, select Hidelshow Legend. Now the legend is no 
longer shown. 

41, From the window menu, select Attributes of Lots to make the table of the 
theme activate. From the Table menu selects Remove All Joints. The table 
of the theme loses the annexed fields and the theme is reverted to a 
monochrome symbol. 

Linking tables 

When the relationship between the destination tables and source is one to many, you 
should link the tables in the places of association. The same as association, the link 
requires that the two tables share a field in common. When the tables are connected, 
selecting a registration in the table destination selects all the registrations in the source 
table that have the same value for the common field. 

42. Click on the window of the project to make it active. Click on the icon for 
Tables. In the list of tables, click on the Proprietors table and then click on 
Open to open the table. 
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The table contains the name and the address of the proprietors of the 
parcels. The table of the proprietors like the table of the theme, contain a field 
called Parcelid, which serves as the common field. The relationship 
between the table of the theme and the table of the proprietors is one to 
many, because each earth parcel can have more than a proprietor. 
Therefore we will make a connection instead of an association for the table. 

43. Move the Proprietors table to the left upper part of the application window, 
then click on the field Parcelid to stand out it. 

44. Make the table Attributes of Lots activate and move it to the lower right part 
of the application window. Click on the field Parcelid to highlight it. 

45. With the table Attributes of Lots activated, from the menu select Theme 
Link to unite the tables. The tables are associated, but the fields are not 
annexed to the destination table and the table source remains open. 

46. Make sure that the Select Record tool is stood out . Select any 
registration in the table Attributes of Lots. The corresponding registrations 
are selected and they stand out in the Proprietors table. The earth parcel is 
also stood out in the view. Inside the parcels there are some that have 
multiple proprietors. 
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47. In the table Attributes of Lots looks for the field Parcelid. Click on - the - 
- 

header Parcelid to highlight it and then click on the Sort Descending 
button to order the registrations from bigger to smaller values. 

48. With the Select Record tool still projected, click on the registration with a 
value of Parcelid equal to 1964. 

49. Click on the Proprietors table to make it activate, click on the Promote 
button. The selected registrations move to the upper part of the table. 

50. With the table of Attributes of Lots activate, from the Theme menu, select 
Remove All Links. 

For you to explore: 
Repeat the steps from 42, but this time instead of selecting Link use Join. What 
happens with the parcels that have multiple proprietors? 

Close the project 

51. Click on the window of the project to make it activate. From the File menu 
chooses Close Project. 
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IV. Handling Primary Data: Creating and Editing 
7Bemes in ArcView 

CATIE has requested us to elaborate a map and a database with the lots that are 
managed in the administrative area of the property of the institution (we won't make the 
whole area for matter of time). This cartographic database could later be connected to 
the system of database of administration of the property and would this way visualize a 
series of variables that could contribute to a better taking of decisions. 

Starting ArcView and opening a project 

1. Start ArcView (a portfolio exists called ESRl in the menu of programs). 

2. Open the called project c:\proarca\ejer5av\edit-temas.apr. When the view 
opens up you will have a view that shows an orthorectified aerial photograph 
of the area that corresponds to the property of CATIE. It is also observed in 
red the limit of the property of CATIE. 

You can create a new theme (polygon, line or theme) in a view that uses the 
coordinates of the places of an existing theme (aerial photography in this case). For 
example, starting from this example we can create a map of the use of the land for the 
property, a map of communication roads, a map of the lots of the property and 
constructions, etc. Once a new theme is created, elements can be added and then their 
attributes. This procedure is known as on screen digitalization. We will proceed now 
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to trace the lots of the property of CATlE with reference to the polygons that are shown 
next, with their respective table (you can Zoom on the picture to observe the areas of 
interest): 

The first thing to do will be to create a new theme that receives the polygons 
corresponding to the lots that we will digitize and then to modify the legend in such a 
way that only the borders of the polygon are drawn (outlines). 

Creating a new theme and modifying its legend 

3. From the View menu, choose New Theme to display the dialogue box. 
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4. From the Feature Type list, select polygon and then click on OK. 

5. In the next dialogue box, navigate to the directory c:\proarca\ejer5av and 
change the File name to lotes.shp. Click on OK. A new file of polygons is 
added to the list and it is ready to be edited. 

6. Click on the checkup box of lotes.shp to make it activate. 

7. For omission, the theme Lotes.shp has a pattern of solid filling. The polygons 
that we add to this theme will cover the themes that are under them. Since we 
want to see behind the polygons, we will change the legend for Lotes.shp to 
a transparent symbol with a border that stands out. 

8. Double click in the box of Lotes.shp in the Table of Contents to open the 
Legend Editor. Double click in the rectangle Symbol to display the Fill 
Palette. 

9. In the Fill Palette, change the pattern from solid to transparent, making a 
click in the first white box. Make the line thicker by going to Outline, 
(selecting 2 from the list that is presented). 
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10. Now click on the Color Palette to display the colors. From the Color list 
choose Outline, and then click on the square of the celestial blue (cyan). The 
polygons with a celestial blue border will be easy to see in conjunction with 
the border of the property. 

1 1  Click on Apply in the Legend Editor in order to apply their changes to the 
legend of Lotes.shp. 

12. Close the Legend Editor and the Color Palette box. 
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Fixing the automatic alignment 

If you add lines to the theme and want to intersect lines that meet at the same final 
point without having extra lines (overshoots) or lines that do not reach the line they 
should intersect (undershoots), you use the automatic alignment. 

DISABLED AUTOMATIC ALIGNMENT 

When the automatic alignment is fixed, ArcView moves the vertices or the segments of 
the line of the new line that you added and aligns them with the vertices of the line 
segments of the lines already existing that are within the specified distance. 

You can also use the automatic alignment when polygons are added to a theme and if 
you want the new polygons to join with the existent polygons in such a way that holes 
or over positioning don't occur between adjacent polygons. 

When you want the new elements join to existing elements inside a specific distance, 
uses the general alignment (General Snapping). The general alignment is a 
characteristic of alignment from element to element that is applied after a new element 
is added. 

If you wants to have more control in how the new elements join the existing elements, 
use the aligned interactive (Interactive Snapping). With the aligned interactive you can 
apply different rules of alignment for each vertex while a new element is added. You 
can choose one of the following rules: 

To align to the vertex: align the next vertex that you add to the nearest 
vertex in a line or existent polygon. 
To align to  the barder: align the next vertex that you add to the nearest 
line segment in a line or border of existing polygon. 
To align to the intersection: align the next vertex that you add to the 
nearest common vertex between two lines or existing polygons. 
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To align to the Final Point: align the next vertex that you add to the final 
point of the nearest line. 

Now you can fix the automatic alignment by using the mouse 

13. Put the cursor in the view and press the right button of the mouse to display 
the menu. Move the mouse down until you reach Enable General Snapping, 
then release the right button of the mouse. You will fix the tolerance of 
automatic closing in the view using the General Snap tool. To make it easier, 
you will first Zoom In on the view. 

14. Click on the Zoom In tool and then draw a rectangle in the center of the 
main square of CATlE to bring a smaller area closer, as is shown next. 

a 
15. Click on the General Snap tool .IT . Position the cursor in the view, then 

click and pull a circle with a radius of 20 meters (the radius of the circle is in 
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the bar at the bottom of the screen). This radial value becomes the automatic 
tolerance for alignment or snapping. 

17. Now that you have seen the closing tolerance, we will add elements to the 
new theme. First we will make an adjustment to the previous extension. 

18. Click on the button Zoom to Previous Extent , and then zoom that to 
the area that is contiguous to the entrance of Cabiria, on the highway that 
leads from Turrialba to CATIE (almost in front of the University). This does 
not corresponds to the lot with identification 1. 

-- - 
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Adding elements and attributes to the new theme 

Now we will add polygon 1. Previous to this we need to create the fields that the table 
needs to take the lots. First you will add a new field to the theme table to store the data 
of the table: 

W 1 Ll* I Dr./& I 
1 ; LOS Oltvos i CaRa _ ...... _ ..... _ .......... . _ _ _  ..... " < 

2 ! .. Los - Bonilla i Caiia .Area de lnvest~gacih . . 
3 i Caiia i Caiia 

" .... " " . " .- " ....... " .... < 

4 :  ICE i Plopledad ..... del ICE .. .. " " . < * 
5 i b i i a  i CaRa . 

" " " .- " < 

6 i Las Palmeras i Cafe " . " -. " - " 

7 Caiia i Caha .......... ........ " " " " 
8 Amarillo - - - i Cale i " .................. < 

9 Potreros frente a Ofic~na i Polteros de terneras y vacas secas ................................................................ - ...... - ..-..... ( . -~ 

12 . La Guardla i Cale .- . .. ......... ................................. ? 

13 Llama i Cafe orglnico ... ........... . .- ...................... ............. ............ : 
14 i Las Cabras ; Moreral . . ... .................................................... ...... .............. < 
15 Las Mulas i CaRa .... .... ....... ................... i . + 
17 Bosque i Parche boscoso .. * ............................. - ......................... - .... - .............. < 

18.  Las Mulas .... "". ....................... ............ "--( 

19 : Los Zanie~os i Potreros y Pastera .............................. __*. ..... ........ . .............. $ 

20 i Charral i Charral ....... _ +  ............................................ __ ..... ............... . ........... 4 

21 I Potreros de Lecheria i Alrededores de lecheria ..-. ............................................................ "" ....... .- ..............._.. "! 

22 1 Establo y El Teca l Potrsos ... * 
23 1 Potrero Potrero .... ! .............. _ _  ........... _" ... _ ......... ._._ ... t 
24 i Caiia .................... .. ................. r !  - . i 
25 i Serniestabulado ; Potrero ................................... . .- ............................................ .- ....................... 

Potreros de caballos ................................................. ............... . 2~ . i .Cd~ .?eSa~~.~ .~~~~~.~~ .~~ .~ .~ .~ .~~~~~.~~~~.~~~~~.~  ................................ _ I 
27 i Altos de Don Enrique , Potreros de vacas secasy novillas i ............. ........... - .................................................................. ' 
28 i La Bomba l CaRa ....................... .....- _.. z 
29 i Palatito i CafC .................... ...* ......................... ...... .......- ........................ .._ .............. "_ $ 

.30-E!.T.~?r! .. ........................................... .iCaSa ................ ........................ i 
i Cafe .............. .3!..Lotee_S.je!eeeee ..... eee..e .................... . ......I............ ..... ._ ...... j 

32 i Abandono i Caiia -. .............. .... -. . .- ................................................. 
33 i Potrelo i Potrero ................................ ................ ........ .......................... ' 
34 i El Cinco i Cafe ................................................................................................................................. 
35 ' Florenc~a Norte ; Caha ................... .*... .-.... ........................................... ............. ' 
36 1 Los Sotos ..................................................................... i.cafe .....- 
37 : Basque i Parche boscoso ..................................................... .... ... .- . .. 
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19. Click on the button Open Theme Table to open the table of Lotes.shp. 

Notice that there is a field called Shape and another called ID, but there are no 
records in the boxes. Now you will add a field called Lote and another field 
called Details to the table. 

20. From the Edit menu, select Add Field to display the respective dialogue box. 

21. In the Field Name, write Lote and in the Type list select String, so we can 
enter a text chain. Select 40 as the field width. 

22. Click on OK. The new field Lote is added to the table of the theme. 
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23. From the Edit menu, again select Add Field to display the respective 
dialogue box. 

24. In the Field Name, write Detalle and in the Type List select String, so we 
can enter a text. Select 50 as the field width. 

25. Click on OK. The new field Detalle is added to the table of the theme. 

26. Position the viewer and the theme table on the same screen, in such a way 
that they don't overlap, then make the view active. 
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Now we will use the Polygon tool to draw a polygon representing the area of the 
Lote No. I. 

27. Of the list of hanging tools for drawing, choose the Polygon tool . 

28. Now you will add the polygon like it is shown below. Click to enter each vertex 
and double click to complete the polygon. 

- - 
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29. Now make the Theme Table active. A record has been added for the polygon 
that you made. Now you need to enter a I as your ID, Los Olivios as the 
Lote, and Cana as the Detalles 

30. Click on the Edit tool. 

31. Now Click on the lowest record in the field and write I, then press Enter. 
Click on the lowest record in the Lote field and write Los Olivios, press the 
Tab key to move to the following field and write Cana in the Details field. 
Press the Enter key. 

32. Now you will add a similar polygon for 2. Follow the steps from the 26 to the 
30 to add this polygon. Make a convenient Zoom In of the area where the 
polygon is in such a way that whole of the area is displayed in the window. To 
digitize on the screen it will be necessary to maximizes the display screen of 
the program in such a way that it takes advantage the whole area of the 
monitor. 
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33. Make the table window active again (if it has disappeared behind the window 

% i 

of the view, can go to the Window menu and select it by clicking on the name 
Attributes of Table.shp. 

34. Insert ID number 2, the name of the Lote and the corresponding details, then 
return again to the window of the view. 
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Editing adjacent elements 

Now we will add lot. 4. In this case the lot is adjacent to lot. 2 (lot. 4 shares a single 
side with the lot. 2). For we will use the tool called Autocomplete. 

35. From the list of hanging tools for drawing, choose the tool AutoComplete 

36. Draw a line beginning in (or inside of) the border of the adjacent polygon (Lot 
No. 2). Click to enter each vertex and double click to conclude the line in (or 
inside of) the border of the adjacent polygon. Note: The two polygons share a 
common border, so it is not necessary fo complete the polygon where the 
common border exists. 

37. Now make database for the theme active. With the Edit tool selected, click on 
the illuminated record in yellow under the field ID and write 4, then complete 
the other two respective fields. 
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Now add the polygons 3, 12, 6, 8 and 13 following the procedures seen in the 
previous steps. When you finish this process the theme and table should appear like 
this. You can vary the order of the records according to the order that you 
introduces the polygons, without effecting the final result. 
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Addition of polygon islands 

The polygon islands are completely contained inside another polygon. For this effect, 
ArcView provides an operation called Subtraction of Polygons. The strategy in this 
case is to digitize the biggest polygon first and then the polygon island. This is because 
when the subtraction operation is executed, the element that is on top is subtracted 
from the element that is below. The part of the feature which is beneath the overlay is 
removed, and the upper layer remains unchanged. 

45. Digitize the polygon No. 7 and introduce the data to the database, like it is 
shown below. 
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3 i CaEa i CaFia ................... .__...+ ..... ___ ................................................................. & ......................................................................... < 

4 i ICE i Propiedad del ICE ......................... * ......................................................................... * ......................................................................... 
6 i Las Palmeras i Cafe .................. ................................................................................. * ......................................................................... < 

8 i Amarillo i Cafe ................... ......................................................................................................................................................... < 

12 ! La Guardia I Caf6 ................... -.- * ..................................................................... ...., 
13 I Llama / Cafe organic0 ............................................................................ ........................................................................ .< 

46. Change the value of the tolerance of the automatic Alignment to more or less 
5 meters (see step 15). Later digitize the polygon No. 17 and introduce the 
respective data in the table. 

CaRa i CaRa ..................... .................................................. , ......................................................................... ; " ; 

4 :  ICE I Propiedad del ICE ................................................................................................... & ; 
6 i Las Palmeras j Cafe ......................... 6 .........................................................................+............................. " .......................... " .............. ; 
8 f Amarillo i Cafe ......................... * .- ..................................................................... i.. ....................................................................... < 

12 ! La Guardia i Cafe ......................... * .................................................................................................................................... ........... + 
13 ! Llama i Cafe orgAnico ......................................................................... ................................... " .............................................................. ; < 

20 i Charral i Charral ......................................................................... ........................ ......................................................................... < 
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47. Select both elements (polygons) make a click with the selection tool 14- and 
then make a click in the external polygon (big), press the Shift key and then 
click on the small polygon (handles will be noticed around each one of the 
elements, 8 handles for the graph). Another way to select is to highlight them 
both in yellow directly from the table. 

48. Once the two polygons are selected, from the Edit menu select the option 
Subtract Features. Although seemingly nothing happens, the area that 
represents the polygon island has been subtracted from the area of the 
external polygon. If one doesn't make the subtraction operation the polygons 
would be overlaid and the area of the external polygon would include the area 
of the internal polygon. You can revert the order of this operation (to subtract 
the one beneath from the one above) by continuing to press the SHIFT key 
when you choose to Subtract Features of the Edit menu. 

- 
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There are three more options that exist in the previous menu: 
Combine Features is used to create polygons that have a hole in the 
interior. In this case we digitize the external polygon first and later the island. 
The two polygons are selected and you click on made in the Combine 
Features option of the Edit menu it. If the polygons are not overlapping they 
behave as the union. 
Union Features if the polygons are adjacent (they share a common 
frontier), the union removes that frontier to form a single polygon. If the 
polygons are not adjacent is a polygon is formed with multiple sides. If the 
polygons are overlapping, the frontiers are removed from the overlap and 
only one polygon is formed. The result of the union creates a unique record in 
the database, even for numerous polygons. 
Intersect Features creates a new polygon of the shared area among the 
selected polygons. 

With these instructions you have the capability to finish the digitization of the 
remaining polygons in order to complete the rest of the table. 

If you do not finish in a single day of work, you can keep their changes by using the 
following procedure. 

To stop editing and save the data 

When the editing is complete we will be ready to save the data. 
49. From the Theme menu selects Stop Editing. 
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50. When asked if you want to save the edits, click on YES. You have 
successfully mapped and updated the areas of lots on the property CATIE. 

Close the project 

51. Click on the window of the project to make it activate. From the File menu, 
choose Close Project. Click NO to the changes, they were previously saved. 
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V. Managing 'Layouts': Production of Printed or 
electronic Maps, Projection, Scales, Symbols 

The data of this exercise corresponds to the area of influence of the Project 
Plama-Virilla and it covers the high part of the Basin of the River Virilla in Costa 
Rica . The data are without a projection (in geographical coordinated). 

Beginning ArcView and opening a project 
40. Start ArcView (a portfolio exists called ESRl in the menu of programs). 

41. Open the project called c:\proarca\ejer6av\layout~.apr. When the view 
opens up you will see a project window that contains the view Cuenca 
(basin) of the River Virilla. You will utilize the view and the view of 
Costa Rica as elements for the design of your map. 

The map consists of a layer that shows the Schools that participate in 
the project of environmental education, the properties that participate in 
the reforestation project, the points where the superficial water quality 
monitoring of the basin is made, the main rivers, the restricted areas 
of use inside the basin and the basin with its division in micro-basins (5 
in total). In this exercise you must liberate the choice of colors, and 
locate the symbols that you desire for the design and creation of the 
map. The present tutorial is only a guide so that you may develop your 
creativity. 

Managing Layouts -66- 



Using Arcview 3.2 

To create the symbols for each one of the elements to 
represent in the map 

Making use of that you have learnt up to now in the course, choose the 
symbols that to you represent the elements for points and lines. You will only 
be given an example of how to load additional symbols that come with ArcView 
and that can be used to represent punctual and lineal elements, as well as new 
palettes of colors. 

42. Double click on the name of the theme Participant Schools to display 
the Dialogue box of the legend. 

43. Double click on the symbol that represents the Participant Schools to 
display the Marker Palette. 

44. Click on the button for adding palettes and then click on the button 
you Load. 

Sav e... I 
Ckar 1 

45. Navigate to the directory c:\esri\av~gis30\arcview\symbols and 
choose the outline of a symbol called forestry.avp and click on OK. 
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46. Repeat the previous step for the palettes C256.avp, envtl.avp, 
colormrk.avp and municipl.avp. The first palette adds 256 solid colors 
to display polygons. The second, third and fourth add environmental 
symbols, additional markers and municipal signs to display point data. 
The palette for points that was loaded in the previous step is for symbols 
related with forest activities. 

47. Now return to the Marker Palette window and select the symbol to 

represent the schools . If you wants to choose other more appropriate 
symbol, do so now. You can vary the color of the symbol to your 

pleasure by clicking on the paintbrush icon so that the color 
palette displays (observer that now there are more available colors). 

48. Change the symbols for the points that represent monitoring superficial 
water and participant properties. Also change the colors with which 
the themes polygons are represented until you one that you like. Verify 
that the legend of the theme Restricted Areas coincides with what is next 
observed. Also, hide the legend for the theme Cuenca. 
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To project the views to Lambert Conic Conformal 

As it was mentioned in the beginning, the views of the Cuenca of the River 
Virilla and Costa Rica, are without data projection. So that the data is displayed 
in plane coordinates, it is necessary to project them. You will project the view of 
the Cuenca of the River Virilla, but you will remember that this projection is only 
for display effects and that the file continues being in LatitudelLongitude. 

49. Choose Properties from the View Menu and Click on the button 
Projection to fix the projection of the view. 

50. From the window of the projection you choose the option Custom and 
select the Projection Lambert Conical Conformal and the Spheroid of 
Clarke 1866. Then copy the parameters of the Projection that are shown 
next and click on OK. It indicates you that now you have a plane 
projection in places for the geographical coordinates. 

- - 
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51. When you return to the properties window of the of the view it fixes the 
distance units as Kilometers. 

TO CREATE A DESIGN IN THE PROJECT 

52. Click on the window of the ~roiect  to make it activate. Double click on the 
1 a 

Layouts icon to create a new design. 

53. From the Layout menu, choose Page Setup and change the orientation 
of the page to Horizontal (oblong), and then click on OK. 

54. Make the drawing window bigger by dragging the lower right corner. 
Notice that a grid appears in the design page to help locate the elements 
of the map on the page. This grid is for display purposes and you won't 
appear in the printed design. 

In order to explore: 
1. Go to the Layout menu and select Properties. Make use of Help describes 
the meaning of each one of the options that you find in that dialogue box (Grid 
Spacing, Snap to Grid). 

Adding a view and legend to the design 
To add the view Cuenca of the River Virilla to the design, you should first add a 
mark to the page. 
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- 
55. Click on the View Frame tool (Mark View) . 

56. Move the cursor to the page of the design (it changes to a cross). As it is 
shown below, click on the left button and keep it pressed while you drag 
it to the lower right corner and then releases the button of the mouse. 

57. When the View Frame Properties dialogue box appears, click on the 
view Cuenca of the River Virilla to select it. To accept the other options 
for omission, click on OK. 
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In order to explore: 
2. Making use of Help in ArcView, which give an explanation of the options 
that there is for Live Link, Scale, Extent, Display and Quality of the previous 
window. 

58. The view Cuenca of the River Virilla appears in the design. 

Note: If you are not satisfied with the size or the position of the mark of the 
view, you can use the pointer tool to select it, to move it or rescale the image. 

. . . . . .  . . . . . . . . . . . . . . . . . . . . . . . .  
. . . . . . . . . . . .  L . .  . . . . . . . . . . . . . . . . . . .  

. .  . . . . . . . . .  . . . . . . .  
. . . . . . . . . . . . . . . . . . . . . . . . . .  F: : . 

. . . . .  . . . . . . .  . . . . . . . . . . . .  I 
Now you will use the legend of the theme in the view to create a legend in the 
design. 

59. Before you can add a legend, a legend mark should be added to the 
design. Click and hold the button of the mouse in the Frame tool, drag 
the mouse down and select the Legend Frame tool and then release 
the button of the mouse. 
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60. As it is shown below, click and hold the button of the mouse, drag it to 
define a legend mark and then release the button. 

The dialogue box of the Legend Frame Properties appears. 

61. To join the mark from the legend to the mark of the view, double click in 
ViewFramel: Cuenca of the River Virilla and then press OK. The 
legend of the view Cuenca of the River Virilla appears in the design. 
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Adding a scale bar and a north arrow to the design 

62. Select the window Layout1 to make it activate. Click and hold the button 
of the mouse in the Frame tool, drag the mouse down and select the 
Scale Bar Frame tool and then release the button of the mouse. 

As it is shown below, click and hold the button of the mouse, drag it to 
define a mark for the scale bar and then release the button. 

-- -- 
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The Scale Bar Properties dialogue box appears. 

64. To join the mark of the scale bar, double click in ViewFramel: Cuenca 
of the River Virilla. Fix the units to Kilometers and the intervals to 3. 
ArcView fixes the number of intervals according to the size of the mark 
of the legend bar. Fix the divisions to the left to 2. This will create a scale 
bar in which each division to the right of the zero represents 3 
kilometers, and each division to the left of it represents 1.5 kilometers. 
Click on OK. 

65. The scale bar appears in the design. 
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If the scale bar is not centered under the mark of the view, you may wish to 
change the position. To adjust the position of the marks in the design, the 
pointer tool is used E l .  
66. Click on the Pointer tool, then position the cursor on the edge of the 

scale bar until the cursor changes to an arrow with four heads. Drag the 
scale bar to the new position. 

Now you will add a North Arrow for the design. 
67. Click and hold the button of the mouse in the Frame tool, drag the 

mouse down and select the North Arrow tool and then release the 
button of the mouse. 

68. As it is shown below, click and hold the button of the mouse, drag it to 
define a mark for the North Arrow and then release the button. 
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69. The North Arrow Manager dialogue box. Select a north arrow. Click on 
OK. 

70. Move the North Arrow to a location that you feel is the most appropriate. 
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To add a title and an image to the design 
Before adding a title to the design, you first must determine the size and the 
source of the title. 

71. From the Window menu select Show Symbol Window. Click on the 

Font Palette button to open the respective box. 

72. Fix the source to Arial, the size of the text to 36 and the style to Bold. 

73. Close the window. 
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74. Click on the Text tool . 

75. Move the cursor inside the page of the design, click near the upper part 
of the design to position an insert point for the text. The Text Properties 
window appears. 

76. Type Cuenca Alto del River Virilla as the title of the map. Click on OK. 

77. Using the pointer, position the title in the place that you consider most 
appropriate. 

To make the map more distinct, you will add a logo (this could be the logo of 
your company) beside the title. To do this, you need to add a mark for the 
image. 
78. From the Frame tool, select the Picture Frame tool. 

79. Make a box in the lower right part of the page. 
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Cuenca Alta del Ria Uirilla 
A 

Or$gin. (3 25.0 751 in E*le.ii :' C3 0 '51 In Aiea 0 75 sq n 

80. Click on the Browse button in the Picture Properties dialogue box and 
navigate to the directory c:\proarca\ejer6av and select 
logoplama.bmp. Click on Open and OK in the dialogue box. 

81. Click on OK on the Picture Properties dialogue box. A graph with the 
logo of the project Plama-Virilla appears. 

82. If the logo appears covered by the window of the map, select the image, 
go to the Graphics menu and press the option Bring to Front (to bring 
to the front). This will place the image in the foreground of the display. 
Move the logo to where it suits you. 

Adding a border to the design 
83. From the Draw tool, select the Rectangle tool. 

84. Use the tool to draw a rectangle around the whole design iike it is shown 
below. 
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85. From the Window menu, select Show Symbol Window to open the Fill 
Palette. Fix the width of the outline to 4. This will make it thicker. 

C u e n c a  Alta d e l  Rio Virilla 
d a 

Adding graticules and measurement grids to the design 
86. From the File menu chooses the Extensions option and activate the 

extension Graticules and Measured Grids. Once selected click on OK. 
This will load an extension that allows to add graticules and measured 
grids to the map in the design. 
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1 conKns aTool  for mak~nq qrat~cules and measured 
rids on viewframes in a layout .  ("3.1) 

87. Click on the button of Adding Graticules and Grids and the 
respective dialogue box will be displayed. 

88. In the dialogue box that appears we will only select the option to create a 
graticule and a grid. The graticule is used when the data are not 
projected (the original file is in latllong) and also when we do not have a 
fixed projection for the map. When the map is not projected but the 
projection is fixed (using the View Properties) it is therefore possible to 
fix a graticule (latllong) as well as a measuring grid (for the flat 
projection). If the data are projected because the original file already is 
projected, it is only possible to add a measuring grid, and not a graticule. 

89. Select Cuenca del Rio Virilla as the view to which you want to add the 
graticule. Click on Next. 

90. In the following dialogue box we must choose the spaces of the 
graticules in the horizontal sense as much as in the vertical one. The 
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area that we have only frames an area approximately I I x 7 minutes, so 
we will fix the spacing of the graticules to 2 minutes. Choose Labels 
Only in order to it only generate labels in the margin of the map, fix the 
letter size to 6 points, the source to Arial and leave the other options 
for omission. 

91. In the following dialogue box we will choose the spaces of the grid in the 
horizontal sense as much as the vertical one. The area that we have 
frames only an area approximately of 21 x 13 km, so we will fix the 
spacing of the graticules to 4 kilometers. Choose to display the grid as 
lines, fix the letter size in 6 points, the source to Arial and leave the 
other options for omission. 

92. In the following dialogue box we must choose the border around the 
square of the view (we won't choose a border around the 
graticuleslgrid). We will also choose to align the labels to the borders. 

Managing Layouts 



Using Arcview 3 -2 

Now we can have see a preview of how our graticules will look and we will be 
able to modify it before putting it onto the our design. 

93. Click on OK and observe if your graticules and grid are as you expected. 
If you are satisfied then presses the Finish button. If you believes that 
you should make more changes then presses the Remove button to 
erase the previous view and to change what you want. 

94. Make any necessary adjustments so that there are no overlapping 
among the different elements of the design andlor hide undesirable 
elements by adding blank rectangles filled with white. 
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Adding another image as a location map 
Now we will add an image of Costa Rica to locate the High Cuenca of the River 
Virilla in the design. 

95. Minimize the window Layout1 and make the window active of the 
project, by clicking on the cintillo of the name. 

96. Click on the Views icon of the window of the project and open the view 
Costa Rica. An enlarged view of Costa Rica and the Cuenca of the 
River Virilla in units of LaffLong, will be displayed. 
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97. Return to the window of the design Layout1 and maximize it. 
- - 1 

98. Click on the View Frame tool aei 
99. Move the cursor to the page of the design (it changes to a cross). Click 

on the left button of the mouse and hold, while you drag it to the place 
that you have chosen to locate the location map. 

100. When the dialogue View Frame Properties box appears, click on the 
view Costa Rica to select it. To accept the other options for omission 
you must click on OK. 

101. The view Costa Rica is displayed in the design. Add the title "Map of 
Location" and a rectangle around the map as is shown below. 
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102. Now if you want, you could print this design by selecting the Print option 
from the File menu. If you want to configure the printer first, select the 
Print Setup option of the File menu (see design at the end of this 
tutorial) 

Note: If you are not satisfied with the size or the with the position of the frame 
of the view, you can use the pointer tool to select it, to move it or change the 
dimensions. 
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V1. GIs Management: Geoprocessing of maps 

Many of the new functions in ArcView Version 3.2 are accessed through extensions 
that come with the program and that can be activated or disabled as needed. When one 
chooses the Extensions option from the File menu you open up the Extensions 
dialogue box. Projecting an extension provides information about it. When one makes 
a click in the checkbox, the Extension is loaded in ArcView. 

When the extension of Geoprocessing is loaded, an option appears in the menu called 
View Geoprocessing Wizard. This application executes the automatic help (wizard) 
and can carry out six tasks for spatial data processing. 

Dissolve features based on an attribute is the process of association of spatial data. 
Technically, it is the same to show a table of attributes for a theme and later choose 
summarize where you can select the option to unite the shapes. 
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Assigning data by location is the same process as the spatial merge seen in exercise 
6b. The operation of assigning data by location will carry out a spatial merge between 
the two themes selected. A spatial merge is similar to a merge of attributes, however, it 
is based on the spatial relationship between the elements of the two themes. For each 
element represented in the output table, ArcView looks to see if the elements have one 
of the spatial relationships with any element represented in the source table; if it has 
any, the register of the source table will be annexed in the destination table. 

When the spatial fusion is based on the relationship "nearer" (i.e. none of the two 
involved themes contains polygons and one of them contains points), ArcView adds a 
field called "Distances" in the destination table. This field is calculated automatically in 
ArcView and it contains the distance to the nearest element represented in the table 
source for each element represented in the table destination. The distance is calculated 
in the units that the view has. When the spatial fusion is based on the relationship "part 
of' (i.e. both involved themes contain lineal elements), the lineal elements represented 
in the table destination have to be segments of the lineal elements represented in the 
table source in order to satisfying the spatial coalition. In other words, the lines of a 
theme are part of the lines of another theme. For example, if the River Virilla is in one 
theme and all the rivers of the basin of River Tarcoles are in another theme, all the 
elements in the first theme are considered "part of' the elements of the second theme. 
This is because the River Virilla is a tributary of the Tarcoles and the elements that 
represent the River Virilla are present in the second theme. 

Merge themes together adds the elements of one or more themes to those of another 
theme of the same type. A new exit file is created that contains all the elements of each 
one of the entrance themes. The names of the fields in the exit theme are taken off the 
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selected entrance theme. The attributes of the other themes are included in the exit 
theme if the names of its fields coincide with those of the selected entrance theme. 

The new theme will contain the fields of one of the entrance themes. If each one of the 
themes has at least the same fields, then all the cells in the table of attributes of the 
new theme will be filled. If some of the other entrance themes have additional fields, 
these data won't be included. If some of the other entrance themes have lost fields, 
then the data won't be added to these fields for the elements of this other theme. 

Clip one theme based on another is applied to a polygonal theme (call the theme a 
"cut out") that acts as a mould for making cookies. The result is a new theme in which 
the elements of the entrance theme are cut at the borders of the theme "cut out" (or to 
the borders of the elements selected in the theme "cut out") 

The process creates a new shape file by means of overlaying the two themes. One of 
the themes should be a polygon (also call the theme "overlay") which will be used to 
define the region to clip. Only those elements in the other theme (called the theme 
"entrance") inside the region of clip will be kept in the new shape file. The elements of 
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the exit theme will be of the same type as the elements of the entrance theme. The 
elements of the table of attributes for the new file contain the same fields as the 
entrance theme. The table of attributes of the new file contains the same objects of the 
table as the entrance theme. 

Intersect two themes calculates the geometric intersection of the two themes and 
adds to the view a new theme. The overlay theme should be a polygonal type. Its 
elements cut the entrance theme. Any elements in the entrance theme that are not 
covered by the elements of the superimposing theme will be ignored. Only the areas 
that are common to the superimposing theme and to entrance theme will be included in 
the exit theme. The elements of the entrance theme can be polygons or lines. The 
elements of the exit file will be of the same type as the elements of the entrance theme. 
The table of attributes of the exit file will include the attributes of the entrance theme 
and that of superimposing. 

r~bute data from 

Union two themes creates a new process for superimposing two polygonal themes. 
The exit theme contains the combined polygons and the attributes of both themes. The 
polygons of the entrance theme are cut in the intersection with polygons of the overlay 
theme. The table of attributes of the theme to be produced contains the attributes of the 
tables of attributes of the input theme and output. 
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To clip, combine and dissolve themes 

1. Open the file called ejerl0-geo, which will create the directory c:\proarca\ejerGav 
and will display the necessary files for this exercise. 

2. Open the project called "geoproceso.apr" that is in the directory of work 
c:\proarca\ejerGav. You will see the cartographic database that corresponds to a 
sub-basin of the river Pirris displayed. The information that is presented (as can be 
observed) consists of a map of the rivers, vegetation and the river curves on two 
pages of cartographic sheets, divided by north and south. We also have a file 
corresponding to an aerial photo that we will observe later. 
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In the case of the rivers and the curves at the level, the files have already been 
clipped to the study area defined by the theme "rnarco.shp." However, the curves of 
the rivers are divided in two files: rios-sur and rios-norte, and curvas-sur and 
curvas-norte, for what will be necessary to combine them so that they conform a 
single file. In the case of the vegetation, first the files will be clipped to the study area 
(clip) and then they will be combined to form one whole (merge) 

3. From the View menu choose the Geoprocessing Wizard option. Select the option 
"Clip one theme based on another." Press the Next button. 

4. In the following dialogue box, select the entrance theme (I) as Veg-sur-full.shp, 
for the superimposing theme (2) select Marco.shp and for the exit file theme (3) 
select c:\proarca\ejer6av\vege_sur and then press the "Finish" button. The new 
theme will be added to the table of contents. 

5. Activate the theme Veg-sur-full.shp in the contents table and select the option 
Delete Themes from the Edit menu and then choose the option "Yes" to conclude 
the erasing process. Drag the new theme to the place that occupied the file erased 
in the table of contents. 

- 

GIS Management 



Using Arcview 3.2 

6. Repeat step 4 but this time for the entrance theme use Veg-norte-full, the 
superimposing theme (2) the theme Marco.shp and the exit file c :\ 
proarca\ejer6av\vege-norte and then press the "Finish" button. 

7. Erase the theme Veg-norte-full from the table of contents and move the new 
theme to the place that occupied the file that was just erased. Click on the themes 
so that they are displayed in the window of maps. Zoom if it is necessary to enlarge 
the study area. 

8. Now we will combine the themes of the rivers, curves and vegetation so that all of 
the files form a single file. Open the Geoprocessing Wizard again and choose the 
option "Merge". 
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9. In the following dialogue box select the two themes of entrance (1) Rios-sur.shp 3 

and Rios-norte.shp (to select the two files, click on one file and then ShifttClic on 
the other), as the themes to combine. It does not matter which fields you use to 
make the combination since the two tables themes have the same fields. Specify the 
exit file (2) c;\proarca\ejer6av\vege_pirris and then press the "Finish" button. The 
new theme will be added to the table of contents. 

10. Repeat the previous step for the files Curvas-norte.shp and Curvas-sur.shp and 
name the exit file curvas-pirris.shp. 

11. Repeat the previous step for the files vege-node-shp and vege-sur.shp and name 
the exit file vege-pirris.shp. 

12. Erase the individual files (north-south) from the table of contents and order the files 
in such a way that in the upper part the rivers are located, then the curves, then the 
vegetation, then the aerial photograph and finally the mark. Change the color of the 
rivers to blue or celestial, the color of the curves to black or gray dark and display 
the vegetation with a legend type "Unique Value" and the field relations to "Type." 
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Highlight the themes Curvas-pirris, Rios-pirris and Vege-pirris and observe the 
results. 

As you will observe the maps of the rivers and the maps of the curves are complete. 
However, the map of vegetation presents a division line between the north part and 
south. This is because the polygons are closed in their respective pages and when 
merging, the program doesn't recognize that they have the same attributes, leaving 
them separated as two different entities. To remedy this, we will proceed to "dissolve" 
the lines that separate the polygons with same identification that in this case 
correspond to the called field "Code." 

13. Open the Geoprocessing Wizard and select the option "Dissolve features based 
on an attribute." Then press the Next button. 
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14. Select Vege-pirris.shp as the theme to dissolve (1). Select Code as the attribute 
with which the breakup of the polygons will be made (2). Specify 
c:\proarca\ejer6av\Vege-pirris-dis as the exit file. Press the Next key. 

15. In the following dialogue box you can choose to add one or more fields to the table 
of attributes. These fields summarize in the way it is specified. To select more than 
one or a range of themes and summarize operations use the keys Control or Shift 
together with a click of the mouse. In this case we will use only Type by First. Then 
press the Finish button. The new theme is added to the table of contents. , 
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16. Erase the theme Vege-pirrisshp from the contents table and move the new theme 
to the place that occupied the one that was erased. Create a legend based on the 
field "Type", as is shown next. 
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VN. Queries and Analysis of Spatial Relationships 

ArcView has several available operations of space analysis that you allows you to 
determine the relationships between two topics: 

You can find elements which are adjacent to other features. This relationship type can 
be made with the selection Theme-on-Theme, allowing you to analyze a space 
relationship, trying to find: 

Adjacency, 
Proximity, 
Intersection, 
Inside. 

ArcView allows us to make a selection of 
the theme selected, (theme-on-theme). To 
utilize this option Select By Theme, go to 
the Theme Menu in the view 
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Selection of Theme-on-Theme 

This option allows you the use of multiple themes to examine the space relationship 
among the features of the topics. 

-Types of Space Relationship 

When we click on Select By Theme, we will see a dialogue box, where we will be able 
to choose the type of space relationship that we want for the theme. 

In this display menu, we may choose the type of 
space relationship that we want from ArcView 

Completely Within The features related with our selection that are 
entirely inside the theme: you can use points, lines 
or polygons that are within another polygon. 

Completely contain The features that are totally contained in the related 
theme 

Have their center in The features whose center falls inside the related 
theme 

Contain the center of That contains the center of the related theme 
l n tersect That intersection of the related theme 
Are within distance of That are inside a specific distance of the related 

theme 

Examples. At this point you will be given an example of the type of selection that 
you should use for some described common cases: 
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-Intersection: you have a limited study area with an intersection of a highway, cutting a 
particular side off from the plot. 
-inside of: we have a coverage of protected areas and another of cultivated areas. 
The Selection would be all the cultivated areas that are inside the Protected Areas. 
-inside of a distance: imagine a coverage of points that represent the towns of a 
country and another coverage of points for the highways of the same country. This 
selection could determine the information on population from the points that are a within 
a specific distance from the highway. 

Selecting Points Near to a Line 

At this point of Space Analysis we are mixing the tools that ArcView provides with the 
objectives of our analyses. 
1. We should know what our main objective is 
2. What is it that you want us to find 

When this is very clear, we go to ArcView and open the project called Gulf of Fonseca. 
A view will open up with the data that CATlE has developed before from PROARCA in 
the area mentioned. 

If we want to know which are the smallest cities that are less than 1 km of distance from 
the main highways, then our main objective is the Cities and Towns (this is 
represented by a coverage of points) 

I )  First select the principle streets on our new theme of Highways 
2) Make our Objective Topic active (Cities and Towns) 
2) Choose from the Theme Menu the Select By Theme option 
3) Choose the topic that is related to your selection (that would be the Highways) 
4) Choose the type of space relationship 

In this case we are looking for the nearest population to the Main Highways, and we have to 
have a distance that will be of 1 Km. Now you already have the relationship type that 
we will use (i.e.: choose Are Within Distance Of3 

Enter the distance that you want to have (the proximity range) (i.e.: 1 Km) (These 
distance units are the units that are used in the View Properties). 

5) Once you obtain this first result, select from the shape Cities and Population only 
the smallest Cities. 

ArcView highlights the points that fulfill the given criteria. 

- 
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Selecting adjacent polygons 

The same as in the previous example, the main topic should be selected, (In this case 
our new polygons). Our new example: Try to find the adjacent municipalities to the 
municipalities that we have selected on the view. 

We select three municipalities that are of 
interest, and we have with which 

1. Selected the Municipalities with the Select Feature Tool 
2. Choose the theme with which we will relate it (in this case the same one). 
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3. Leave the distance to 0 (Because we are looking for adjacent polygons, we don't 
need a specific distance) 

results we 
can see the 
surrounding 
polygons 
that share 
common with 

Selection of Lines above Polygons 

We show an example Know the municipalities that you passes we will use a net, to 
which we will call the Pan-American Highway. 

1. Activate the main objective theme (or boundary proposal). In this case the new 
objective (Target Theme) are the places that may come from a coverage of 
cities. 

2. We choose the theme with which we want to relate it (In this case it will be the 
Pan-American Highway) 

3. We choose the type of space relationship (in this case it would be an 
intersection) 

ArcView selects the municipalities that are connected to the Pan-American Highway. 
Therefore we will have a selection of Polygons (municipalities) that are intersected with 
a line (Pan-American Highway). 
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Selecting Points on Polygons 

We show an example to identify the cities that are inside the selected municipalities. 

1. To activate the theme with the coverage of polygons (in this case the 
municipalities) use the Select Feature tool if we need a single polygon of a 
coverage of polygons. 

2. Choose our objective topic (in this case the Cities and Towns) and activate it. In 
this case we need to know the number of points on a certain polygon therefore 
we choose POINTS 
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3. We choose the topic with which we want to relate it (municipalities) 
4. We choose the type of space relationship. In this case we will use the space 

relationship 'Are Completely Within '. We use it to select the points, lines or 
polygons that are completely inside another polygon. 

The results are observed next. 

A final challenge for the course: 
With the data that you have on the Gulf of  Fonseca, carry out an analysis that allows 
you to deduce which are the percentages for each ecosystem that are found under 
different levels of protection in the area that the maps cover. For this effect, you will use 
the layer of data for the protected areas and for the ecosystems. Present a map design 
of the protected areas. We will use the logo of CATIE, Chemonics, CCAD and of 
USAID. 
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